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Upon Receipt of Product 

Prior to operation, check for loosened hardware or damage incurred during transit. If these 
conditions are found, a safety hazard is possible, DO NOT attempt to operate equipment. 
Please contact Megger as soon as possible. 
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1  
MTO250 General Information 

Product Overview 

The Megger Transformer Ohmmeter (MTO) is a line-operated, field-portable 
instrument designed specifically to measure the DC resistance of all types of 
magnetic windings safely and accurately. The MTO250 is also capable of testing 
non inductive low resistance objects such as breaker contacts, high current 
connections etc.  

The MTO250’s primary value is the measurement of the DC resistance of highly 
inductive transformer windings within the defined ranges of current and 
resistance. The MTO250 will also test rotating machine windings, shunt reactors 
and perform low-current resistance measurements on connections, contacts and 
control circuits. 
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Top Panel Controls 

 

Figure 1: MTO250 Front Panel 

 

Input AC Power Module: 

This module is an IEC320 interface to the mains power. The module has an 
integrated switch and input filter module. The green light on the bottom of the 
module illuminates when power is ON. 

The power input is acceptable from 85 to 264 volts from either a regulated line 
input or from a suitable stable source portable generator, where frequency must be 
between 47 and 63 hertz. Please be aware that at voltages below 120V, a 
potential for inadvertent tripping of the breaker does exist (under maximum load), 
although the MTO250 is self-protected. 

 

Output Current Connector 

This connector is used to connect to the transformer winding(s) and pass the DC 
power into the transformer winding for testing and demagnetization. The 
connection is capable of supplying 50 V dc and 50 A dc current. Connection is 
made via spade lugs on current test leads. 
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Input Voltage V1 

These connections are used to connect a transformer winding for input voltage 
measurement. The instrument will automatically calculate the resistance of this 
input in combination with the current source. The connectors are also used as a 
path for current to flow during discharges. For maximum safety, voltage leads 
shall always be used in conjunction with current leads. 

 

Input Voltage V2 

These connections are used to connect a second transformer winding for input 
voltage measurement. The instrument will automatically calculate the 
resistance of this input in combination with the current source. The connectors 
are also used as a path for current to flow during discharges. For maximum 
safety, voltage leads shall always be used in conjunction with current leads. 
This measurement can be turned off by depressing the ► key located on the 
left side of the front panel, but only prior to commencing a test. 

 

Earth/Ground Lug 

This connection is used to connect a transformer under test to earth ground for 
safety purposes and improving measurements while testing in high 
voltage/high electrical noise stations. The transformer and the MTO shall be at 
the power ground/earth potential when being operated. 

 

Emergency Shut Down Switch 

This switch, when pushed will disable the source power supply and 
automatically discharge the transformer.  

 

Current Set Switch 

This switch is used to control the test current applied to a transformer. 
Resistance readings remain accurate even when set test current is not 
reached, so long as a minimum 25% current setting is reached.  

 

HV Strobe Connector 

When the optional HV Strobe is attached to the connector, the user will have a 
more visible indication of the activation mode of the MTO.  

 

Break Before Make INDICATOR 

Blinking Lamp: If test current reduces >10% for a period exceeding "transition 
time sensitivity setting (set from Ω2 display). Solid LED: Indicates a 200msec 
hard limit was detected and unit automatically shuts down test current. 

Depress   to continue when this condition is reached. 
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Ethernet Interface 

This interface enables data download and MTO250 computer control (via 
PowerDB). This is also used to perform firmware upgrades.   

 

Remote Control Switch 

This connector is used to interface with an optional remote switch. This switch 
is primarily used for testing Load Tap Changer (LTC/OLTC) of a transformer. 

The Remote Control Switch will remotely start the MTO test and store multiple 
resistance readings while making tap changes (LTC/OLTC type only). The 
storage function in remote mode is sequential and notes to the operator each 
stored value’s record number. The unit also stores make-break transition 
events with each resistance. Details of procedure are available below. 

 

Safety Interlock Connector 

These connections are used when there is requirement for additional safety 
while testing a transformer.  

Data Output Mode Switch 

 

 

MTO is in "Test Mode"  

 
MTO is in "Data Review Mode" 

 
MTO is in "Set Date/Time Mode" 

 
MTO is in "Date Format Mode" 

 
MORE DETAIL IS AVAILABLE ON DATA OUTPUT SWITCH OPERATION in Section 5 - General 
Operating Procedures – Common Test Procedure. 
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The TEST LAMP stays illuminated while current is 
flowing, whether in “test mode”, “demagnetization 
mode” or “current discharge” mode. This lamp is 
intended as a safety indicator which when lit 
indicates Do Not Remove Test Leads. 

 

TEST BUTTON – When depressed, the MTO will 
start current flow to the object under test. When 
depressed while current is flowing, current will 
begin a discharge routine and the last resistance 
results will remain briefly on the Ω1 and Ω2 display.

 
When depressed, will start the current discharge 
process.  

 

When depressed, will perform a transformer 
demagnetization. The DEMAG LAMP to the right 
will illuminate during the demagnetization cycle.  

When depressed, the unit will acknowledge data 
entered (if testing), display additional information (in 
review), or confirm data deletion actions. 

 

This symbol highlights that the ►X1 enables the 
user  to DELETE the last recorded result in memory 

( to confirm action). ►X 2, enables the user to 

delete all results in a group ( press  to confirm 
action). ►X 3 takes it out of the DELETE state.

 

 
Current Display 

This 6 digit display provides operator indication of test current level 
(provides 4 digits of resolution).  When reviewing saved results, this 
display indicates recorded current and 'Group-Result. 

 
Ω1 Display 

This display provides operator indication of various parameters. 
Prior to test initiation, displays “temperature” setting for result 

storage, and is changed via / arrows. Once  is depressed, 
resistance value of V1is displayed.  

 
Ω2 Display 

This display provides operator indication of various parameters. 
Prior to test initiation, displays LTC make/break sensitivity setting 
as well as Ω2 ON or OFF setting. LTC sensitivity is changed via ◄ 

arrow and Ω2 ON or OFF is changed via ► arrows. Once  is 
depressed, resistance value of V2 is displayed - if enabled.
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2  
Safety 

Operator Responsibility 

Only qualified and trained operators should operate the MTO250 system. 
Operator must read and understand this entire Instruction Manual prior to 
operating the equipment. Operator must follow the instructions of this 
Instruction Manual and attend the equipment while the equipment is in use. In 
the event of equipment malfunction, the unit should immediately be de-
energized and returned to Megger for repair.  

“The Safety precautions herein are not intended to replace your Company’s 
Safety Procedures. Refer to e.g. IEEE 62-1995/IEEE C57.152, or IEC 
standards for additional information. 

F 
WARNING 

When applying current to a transformer with very high 
inductance, additional care should be taken not to remove current 
or voltage leads while current is still flowing. This causes an 
extremely high voltage to develop across the point where current 
is broken. Under certain conditions, this voltage could prove to 
be lethal.  

F 
WARNING 

It is critical to connect leads securely to the bushings of 
transformers. Ensure that no strain is placed by leads while 
connected, so as to minimize the risk of inadvertent 
disconnection.  

General Safety Precautions 

The MTO and the Unit Under Test (UUT) should both be considered as sources of 
instantaneously lethal levels of electrical energy. Observe the following safety precautions: 

 Observe all safety warnings on the equipment. They identify areas of 
immediate hazard that could result in injury or death. 

 Use this equipment only for the purposes described in this manual. Observe 
strictly the Warning and Caution information provided in this manual. 
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 Treat all terminals of high-voltage power equipment systems as potential 
electric shock hazards. Use all practical safety precautions to prevent contact 
with energized parts of the equipment and related circuits. 

 Use suitable barriers, barricades and/or warnings to keep persons not directly 
involved with the work away from test activities. 

 Never connect the test equipment to energized equipment. 

 Do not use in an explosive atmosphere.  

 Use the grounding and connection procedures recommended in this manual. 
Always disconnect test leads from power equipment before attempting to 
disconnect them at the test set. The ground connection MUST be the first 
made and removed last. Any interruption of the grounding connection can 
create an electrical shock hazard. 

 Personnel climbing higher than 5 feet (1.5 m) should follow proper tie off 
safety requirements. 

 Personnel should use proper safety gear to prevent bodily harm. 

 Personnel using heart pacemakers should obtain expert advice on the 
possible risks before operating this equipment or being close to the 
equipment during operation. 

F 
WARNING 

No user serviceable parts inside! Refer all servicing to the factory 
or a qualified authorized service company!  

G 
CAUTION 

Use only factory supplied mains cord! 
Mains cord shall not be substituted! 

Input Power Precautions 

This instrument operates from a single-phase, sine wave, power source. It has a 
three-wire power cord and requires a two-pole, three-terminal (live, neutral, and 
ground) type input source. The voltage to ground from the live pole of the 
power source must be within the following rated operating voltage: 

For Catalog No. MTO250:  85 - 264 V, single-phase sine, 47-62 Hz >20%THD 

The neutral pole must be at ground potential. Before making connection to the 
power source, determine that the instrument rating matches the voltage of the 
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power source. The power input plug must be inserted only into a mating 
receptacle with a ground contact. 

F 
WARNING 

Do not bypass the grounding connection. Any interruption of the 
grounding connection can create an electric shock hazard. 
Determine that the receptacle is properly wired before inserting 
power plug into the MTO250. 

The control circuits of the instrument are protected by a circuit breaker which 
also acts as an on/off switch. Therefore, no fuses exist in the MTO250. The 
circuit breaker is rated at 15A and is fast tripping style. It also acts as an on-off 
switch for the MTO250. 
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3  
Specifications 

INPUT 85 – 264 V 
47 – 63 Hz >20%THD 
1500VA 

OUTPUT  

User Selectable Current Ranges: 1 A dc 

 10 A dc 

 25 A dc 

 50 A dc 

Test Voltage: 50 V dc 

RESISTANCE MEASUREMENT/DISPLAY  

Resistance: 

 

 

 

 

 

 

For resistance above 20Ω, test current 
will reduce (@ 1A setting) and 
readings up to 1000Ω can be 
measured with accuracy +/- 5% rdg. 

@ 50A 10 μΩ to 40mΩ  - auto ranging  

@ 50A 40 mΩ to 400mΩ  auto ranging 

@ 25A 10 μΩ to 80mΩ  - auto ranging 

@ 25A 80 mΩ to 800mΩ  - auto ranging 

@ 10A 100 uΩ to 200mΩ - auto ranging 

@ 10A 200mΩ to 2Ω - auto ranging 

@ 1A 1mΩ - 2Ω - auto ranging 

@ 1A 2Ω - 20Ω - auto ranging 

Accuracy: ±0.25% reading, ±0.25% full scale  

Resolution: 4 digits 

Displays Two 1’’ high, 6 character, 7-segment, LCDs 
One 0.71” high, 6 character, 7-segment, LCD 

USER INTERFACE B&W numeric displays, keypad 

COMPUTER INTERFACE Via Ethernet port 

INTERNAL DATA STORAGE 9 groups (1-9) of results with 99 sets of results per 
group 
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SAFETY AND STANDARDS  

Conforms to the emissions requirements of EN 61326-1:2006; Clause 7.2: 

CISPR11 Edition 4:2003 Conducted Emissions, Group 1 Class A 

CISPR11 Edition 4:2003 Radiated Emissions, Group 1 Class A 

IEC 61000-3-2:2000 Harmonics 

IEC 61000-3-3:2002 Flicker 

Conforms to the immunity requirements of EN 61326-1:2006; Table 1: 

IEC61000-4-2:2001 Electrostatic Discharge 

IEC61000-4-3:2002 Radiated Immunity 

IEC61000-4-4:2004 EFT/Burst, Power Ports and I/O Ports 

IEC61000-4-5:2001 Surge Immunity, Power Ports 

IEC61000-4-6:2003 Conducted Immunity, Power Ports and I/O Ports 

IEC61000-4-8:1993, A1:2000 Power Frequency Magnetic Fields 

IEC61000-4-11:2004 Voltage Dips and Interrupts 

ENVIRONMENTAL  

Operating: 14° F to 122° F (-10° C to 50° C) 

Storage: -13° F to 158° F (-25° C to +70° C) 

Relative Humidity: 0-90% non-condensing 

DIMENSIONS 8.5 H x 21.5 W x 13 D  
(216 H x 546 W x 330 D mm) 

WEIGHT Net 30 lb (13.6 kg) 
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4  
Parts List and Optional Accessories 

Item Cat. No. 

Transformer Ohmmeter 

120/230 volt, 50/60 Hz input 

MTO250 

INCLUDED ACCESSORIES 

Ground lead, 15 ft (4.6 m) 4702-7 

AC power cord (IEC60320-C13 to US standard 17032-23 

AC power cord (IEC60320-C13 to Schuko CEE 7/7) AC power cord 
(IEC60320-C13 to US standard) 

17032-19 

In-lid Quick Start Guide   4702-7  

Canvas carrying bag (for leadsets)  2005-265  

Instruction manual ATVMMTO250 

PowerDB LITE software version  DB0001 

OPTIONAL ACCESSORIES  

150KV Lead Set 30ft (9 m) c/w: 1004-640 

30 ft (9 m) current Lead set Cat# 2000-787-30  

V1  30 ft (9 m) potential lead set Cat# 2000-700-30  

V2  30 ft (9 m) potential lead set Cat# 2000-701-30  

15 ft (4.5 m) current shorting lead Cat# 2000-788-15  

500KV Lead Set 60ft (18 m) c/w: 1004-641 

60 ft (18 m) current Lead set Cat# 2000-787-60  

V1 60 ft (18 m) potential lead set  Cat # 2000-700-60  

V2 60 ft (18 m) potential lead set Cat # 2000-701-60  

30 ft (9 m) current shorting lead    Cat# 2000-788-30  

750KV Lead Set 100ft (30 m) c/w: 1004-642 

100 ft (30 m) current Lead set, Cat# 2000-787-100  

V1 100 ft (30 m) potential lead set, Cat# 2000-700-100  

V2 100 ft (30 m) potential lead set, Cat# 2000-701-100  

50 ft (15 m) current shorting lead, Cat# 2000-788-50  
Universal Kelvin lead set, c/w current & potential leads, 30 ft (9 m) 2000-789-30 
Universal Kelvin lead set, c/w current & potential leads, 60 ft (18 m) 2000-789-60 
Universal Kelvin lead set, c/w current & potential leads,100 ft (30 m) 2000-789-100 
Hard sided transit case, c/w foam lining, for instrument and leads. 2005-258 

HV Strobe (Beacon) c/w 60 ft lead (18 m) 1004-639 

Remote Hand Switch c/w 60 ft (18 m) lead 30915-220 
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5  
General Operating Procedures 

When testing high-voltage transformers, caution must be used at all times and all 
safety precautions followed. Read, understand, and employ all safety precautions 
and circuit connections described in Section 2 - Safety. 

F 
WARNING 

Ensure that the transformer to be tested is completely 
de-energized. Check every winding. Ensure that all 
terminals of the transformer are disconnected from line 
or load at the transformer. Connections to ground may 
be left in place. 

 

F 
WARNING 

For all testing as described herein, care shall be taken 
to ensure any and all unused clamps shall be isolated 
from each other, from ground, and from personnel. 

 

F 

EMERGENCY SHUTDOWN PROCEDURE 
There are 4 methods to shut down test current to the 
MTO250. They are: 

 Press red EMERGENCY TEST OFF push button  

 Depress the test button  

 Depress the discharge button  

 Turn the power button to OFF (O). 

 
All actions above place the unit into “discharge mode”. 
Please note, discharge lamp will only stay illuminated for 
a brief time with small specimens. 
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Site Preparation 

Choose a location that meets the following conditions: 

 The location is as dry as possible. 

 There is no flammable material stored in the vicinity. 

 The test area is adequately ventilated. 

 Be sure all equipment is de-energized and all terminals of the Unit Under 
Test (UUT) are accessible. Erect suitable safety barriers to protect the 
operator from traffic hazards and to prevent intrusion by unauthorized 
personnel. User provided Warning lights are recommended. 

 Verify that the Local station ground is intact and has impedance continuity to 
earth. 

Making Connections to Specimen 

Connections should be made in the order as listed below. 

1. Ground. Use the Megger supplied safety ground cable (15 ft (4.6 m)) to 
connect the MTO ground terminal directly to local station earth ground. Input 
power source ground terminal should be less than 100 mΩ of impedance to 
local station earth ground. 

2. Connect the Input Power Cord. Before making this connection, insure the 
Input Power Source meets the requirements as listed in Section 2 - Safety  and 
Section 3 - Specifications. Also ensure the ON(│)/OFF (O) switch (Figure 1) is in 
the OFF(O) position. Connect the input power cable to the MTO first, then to 
the power source.  

3. Connect the Ethernet Cable (optional). If the user chooses to use a 
computer, using PowerDB Lite computer software, then connect the Ethernet 
cable between the MTO and the computer at this time. 

4. Connect the Remote Control Switch (optional). If the user chooses to 
operate the Test Button  of the MTO from a remote distance, then connect 
the RCC cable at this time. 

5. Connect HV Strobe (optional). Connect the HV Strobe cable at this time 
and place the beacon in a conspicuous location. Typically, one connects this 
HV strobe to an opposite side of the transformer using the magnetic portion 
of the HV strobe at a height suitable for individuals within the area to see it 
easily.  
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6. Connect Interlock Switch (customer provided) The MTO has an external 
interlock switch feature. Connect the external Interlock Switch via banana jack 
connection to the interlock input jacks on the front panel. The interlock switch 
function is a fail open, therefore if not used, an interlock jumper must be 
placed in the jacks. If the circuit is open IntLoc will be displayed at the middle 
LCD. 

7. Connect current and potential leads (to the MTO end only at this time). 
With the clamps disconnected from the UUT, connect the I and V cables to 
the MTO. Ensure all plugs are fastened securely to the MTO. Refer to 
Application Section 5 - Transformer Testing for specific conditions such as dual 
resistance, optimize saturation testing, etc. 

8. Connecting to the Transformer. When testing high-voltage transformers, 
caution must be used at all times and all safety precautions followed. Read, 
understand, and employ all safety precautions and circuit connections 
described in Section 2 - Safety. 

F 
WARNING 

Ensure that the transformer to be tested is completely 
de-energized. Check every winding. Ensure that all 
terminals of the transformer are disconnected from line 
or load at the transformer. Connections to ground may 
be left in place. 

 

F 
WARNING 

For all testing as described herein, care shall be taken 
to ensure any and all unused clamps shall be isolated 
from each other, from ground, and from personnel. 
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Initial Testing 

Once all the precautions and steps of Section 2 - Safety are complete, and the 
connections to the Unit Under Test (UUT) have been made, operator may 
switch ON (│) the MTO250. See below: 

 

 

 

│ , ON position 

O, OFF position 

 

On power up, an audible beep should be heard, and the MTO250 will perform a 
self-test check, validating hardware and internal firmware is properly operating. 

If an error code is displayed that is uncorrectable, return the instrument to 
Megger or an authorized service center for repair. Refer to Section 8 - Service - 
Maintenance for a list of error codes. If no errors are detected, the current display 
will show “ready”. 

Common Test Procedure  

The user must set the proper test conditions. These are described below: 

1. Set the Function Mode Switch to TEST  mode. This position is required 
for current to be initiated.  

2. Set the Current Range Switch to the desired amplitude. Recommended levels 
are <15% of rated transformer winding under test. 

 

3. The Ω1 window will display the temperature value that the unit will store with 
the resulting data for all subsequent tests. To change temperature setting 
depress / arrows to the desired value (this will not correct displayed 
resistance readings). 

4. If one is testing LTC/OLTC (Load Tap Changer) positions of a transformer, a 
time saving method is to maintain energized current while changing tap 
positions (precautions in Section 2 – Safety should be followed). Operator should 
now set the make/break transition setting as displayed on Ω2. This setting is 
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L0 to L4, and is changed via the ◄ arrow. This setting is related to the 
sensitivity of the LTC/OLTC transition, and typically starts at L1 – 2ms (if 
used). If tap changer is not in optimum condition or of a poorer design, this 
setting is changed to L2-L4 (20 – 80ms) transition sensitivity. Set to L0 to 
disable. 

5. Depress  and the unit will apply power to the transformer and charge the 
winding(s) under test to the maximum current set level. Once the current 
begins to stabilize, the unit will display resistance readings. 

6. For the more highly inductive transformers, proper resistance readings may 
take additional time. This will be noted by the operator via the resistance 
display, which slowly falls or rises (example: by one digit per 10-15 seconds). 

After a reading is stabilized, depress  to save displayed result (saves 
resistance, test current, temperature and make/break values for Ω1 and if ON, 
Ω2). Immediately after depressing  the record value for this result will be 
displayed on the current (I) display.  

The  button makes it possible to record multiple readings while current is 
maintained for load tap changer units on transformers (LTC/OLTC). The 
MTO250 will toggle the stored test results record number in the current display 
every 2 seconds. 

If a reading is mistakenly saved, the MTO250 has built in safe guards to 
minimizing this situation. The MTO250 waits 3 seconds before it allows another 
reading to be recorded. This minimizes accidental double pressing keys when 
saving results. If a reading is mistakenly taken, depressing ►, followed by  
will delete the last saved record. 

7. Pressing  a second time will begin the current discharge of the transformer, 
briefly displaying the last readings on the display. The discharge indicator will 
illuminate during the discharge, and turn off when complete. The result will 
display briefly, but disappear. The instrument returns to 'ready state' until 
another function or  is selected. 

Discharging a Transformer 

 

This button will stop testing and discharge the transformer. The 
Discharge Indicator to the left will illuminate during the discharge 
cycle.  

The MTO discharge circuitry is built-in. It will automatically initiate when the 
current source is disconnected from the transformer. It will also provide visual 
indication of discharging via a lamp to the left of the  button.  
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There are 4 methods where the discharge test circuit in the MTO250 is 
activated (after test current is flowing). They are: 

 Press red EMERGENCY TEST OFF push button . 

 Depress the test button . 

 Depress discharge button . 

 Turn the Power button to OFF (O). 

Demagnetization Function 

 

This button will perform a transformer demagnetization. The 
Demag Indicator to the right will illuminate during the 
demagnetization cycle. In addition, the Ω1 display will show the 
progress and the current display will show each current 
magnitude step by step. 

The MTO demagnetizes the transformer by automatically magnetizing the core 
in the positive and negative direction with multiple cycles of reduced current. 
During the demagnetization, the unit will display the remaining number of cycles 
on Ω1.  
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Using (Optional) Remote Switch 

1. Connect Remote Control Switch (optional accessory) to the remote connector on 
the front panel of the instrument. 

 

2. Power ON (│) the instrument. 

The Unit will detect the remote switch and display 'r n n t 0/1' (rmt 0 or 1) on 
the Ω1 display. The '0' is displayed when the switch is open; the '1' is displayed 
when the switch is depressed. Depressing the remote switch prior to testing 
confirms proper operation of the remote switch. 

3. To start a test sequence, depress  on the front panel. This will NOT begin 
charging transformer (when remote switch is in the circuit) but will illuminate 
the HV lamp in a flashing manner. The remote switch built in lamp will begin 
in the ON state.  

4. The operator should now validate that they are on the proper tap position on 
the transformer LTC (OLTC), and once confirmed, depress the remote switch 

 to begin the first test. 

The remote indicator lamp will slow flash to indicate charging. The MTO250 
HV lamp will now illuminate with a steady light to show current is flowing. 
When the remote indicator lamp becomes solid, the reading is displayed on the 
MTO250. This does not confirm a steady result, only that the reading is 
displayed. Different transformers require different stability times and as a rule of 
practice operator should view the first result value on the instrument and count 
the time (in seconds) to achieve a desirable steady value. This 'wait time' should 
be used for each tap position tested. 

5. Depressing  the second time will save the result to memory. During this 
sequential testing, the MTO continues to monitor and save Make/Break 
transition events (as set by operator in Ω2 display at start of testing).  

6. If a 200ms Make-Break event occurs, depress  and then remote switch  
to continue testing. This will re-activate the test current and begin to flash slowly 

until reading displays on the resistance display. See Step 4. Depress  a 
second time to continue recording. 
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Stored Data Functions – Display/Delete/Download 

The MTO can save up to 891 (99 results per group in 9 groups) test results to 
memory for archival purposes. If data is stored while testing, the unit can step 
through the memory after testing in a review process. 

 

1. Set the Data Output Mode Switch to  (stored results mode). The unit will 
display the last data stored including the results record number and the data 
group (1-9). The result record number, group number and time of test will 
flash on the current (I) display. Depressing  will display detailed results of 
current and two resistance values. Pressing  will alternate between the two 
displays. 

NOTE:  When the MTO storage is full, the message “StorAg FULL” will be 
displayed at power up or when reviewing data.  

2. Depress and to scroll the stored data within a group. Depress  + 
/ simultaneously to change the results 'group' (groups 1-9) to be viewed. 
Each record will display 'group# - record #' in the right portion of the current 
(I) display. 

3. Depress ►to delete the stored data within the group displayed from the unit. 
The unit will ask for confirmation 'rst' on the Ω1 screen and 'SURE' on the Ω2 
screen. Press  to confirm deletion. 

4. Depressing ► a second time will begin a process to delete all stored data 
within the selected group from the unit. The unit will ask for confirmation 'grp' 
on the Ω1 screen and  'SURE' on the Ω2 screen. Press  to confirm 
deletion. 

5. Depressing ► a third time will exit 'delete mode'. 

6. OVERWRITING AN EXISTING RECORD. – From Steps 1 and 2, select 

the result to be overwritten. Depress . The Ω1 display will show 'retest'.  

Change switch position  to  TEST position. Depress  and follow 
Steps 1 to 6 as outlined in 'Common Test Procedure', above. This will replace 
existing record with new results.  

TEST
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Set Time Function 

The MTO can set the Time of Day from the front panel interface. Set the 
function mode switch to the Date Time Setting as shown below. 

 

1. Set the function mode switch (above) to  set time mode. Date will display 
on MTO250 to show 'year' on current (I) display, 'day/month' on Ω1 and 
'time' on Ω2 displays. 

2. The first time change will be year on current (I) display (last 2 digits will be 
flashing). Use  and to change or if correct, depress ◄ and ► arrows to 
navigate to next setting. The active parameter will blink on and off. 

3. Use  to confirm change after each parameter change. 

Set Time and Date Format  

The MTO allows change in the Date Format. This will accommodate different international 
time standards. 

 

1. Set the Function Mode Switch to Date Format Mode. 

2. Depress  or  arrow to select “year/month/day” to “month/day/year” to 
“day/month/year”. 

3. Depress  to confirm any changes made to selected parameters. 

 

  

TEST

TEST
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6  
Transformer Testing 

Testing a Single-Phase Transformer 

Single-Winding Test 

 

Figure 2: Single Winding Measurement 

F WARNING 
Do not disconnect leads until all indicators are OFF! 

PROCEDURE: 

1. Connect line cord to unit and plug into a suitable power source. If using a 
generator, ensure that VA capability exceeds 1500VA and that THD <30% 

2. Connect Safety GND cord from Top Panel to Transformer GND. 

3. Set the following conditions: 
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a. 

 

Set to TEST position. 

b.  

 

Set to desired MAXIMUM TEST 
CURRENT. 

4. Connect current leads (I) to test specimen winding. See Figure 2. 

5. Connect "V1" voltage leads to test specimen winding. Voltage leads should 
always be placed inside (between) current leads and the transformer. Do 
not place potential leads on the current leads, since this will add contact 
resistance to the measurement. Turn power switch ON (│).  

6. Press  button to initiate current flow. 

7. The top smaller display indicates current output and the Ω1 display indicates 
resistance of specimen. 

8. When measurement is complete, press  to terminate measurement and 
discharge current. Discharge is complete when the discharge indicator and the 
test current lamp are off. 

9. Remove the current leads from the transformer. 

10. Remove the potential leads form the transformer. 
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Dual-Winding Test 

This procedure describes the testing of both windings (high and low) on a single-
phase transformer at the same time. 

 

Figure 3: Dual-Winding Test 

F WARNING 
Do not disconnect leads until all indicators are OFF! 

PROCEDURE: 

1. Connect line cord to unit and plug into a suitable power source. If using a 
generator, ensure that VA capability exceeds 1500VA  

2. Connect Safety GND cord from Top Panel to Transformer GND. 

3. Set the following conditions: 

a 

 

Set to TEST position. 
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b.  

 

Set to desired MAXIMUM TEST CURRENT. 

4. Connect "V1" voltage leads input to H1 and H2 terminals of test transformer.  
See Figure 3. 

5. Connect "V2’ voltage leads input to X1 and X2 terminals of test transformer.  
See Figure 3. 

6. Turn power Switch "ON". 

7. Press  to initiate current flow. The top display (I) indicates current output 
and the Ω1 display indicates resistance of primary winding and Ω2 display 
indicates the resistance of the secondary winding specimen. 

8. When measurement is complete, depress  to end the measurement and 

discharge current or depress  button to record the result followed by  
to end measurement.  Discharge is complete when discharge and test lamp 
indicator is OFF – see below. 
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Testing a Three-Phase Transformer 

General 

The MTO250 has sufficient current to saturate and measure windings quickly, 
where only minutes per tap are required. It should be noted that with higher test 
current comes potential issues related to operator/transformer safety and with 
severe core magnetization. Below is application information related to testing 
transformers, but can be applied to shunt reactors and motors/generators. 

Wye Configured Windings 

PROCEDURE: 

1. Three-Phase Wye Configured Winding with Neutral 

 

Figure 4: Reading obtained is one phase per test, Resistance of H1-H0 Winding 

Use the above diagram in conjunction with procedure Single-Phase Transformer 
Test. Switch both current and potential leads for each phase tested. Always place 
the potential lead between the current lead and the transformer bushing for best 
accuracy. 



M 

AVTMMTO250  Rev 3 June 2015  
30 

Three-Phase Wye Configured Winding, No Accessible Neutral  

 

Figure 5: Reading obtained is between pairs of terminals, resistance V = H1-H0 winding and 
resistance V2 = H3-H0 winding (H2 terminal is used to obtain H0 measurement 
point)  

Use the above diagram in conjunction with procedure Dual Winding Transformer 
Test above, except no shorting lead is required.  

Note:  Because H0 connection is inaccessible, the connection to the untested winding is 
used (H2 for this example) to obtain the H0 potential point. Although not 
exact, this is the best approximation for readings of phase to neutral windings. 

Delta Winding Resistance 

Manufacturer’s winding resistance data are usually presented as per winding for 
Y configurations and per terminal pairs for Delta windings. In the rare case that 
manufacturer’s data is presented per winding for a delta connection, the 
recommendation is to recalculate the numbers to terminal pairs and compare 
with the field measurement results. 

Ravg = Average individual winding resistance 

Rtp = Winding resistance between terminal pairs 

Rtp=Ravg*0.6667 
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Demagnetizing a Transformer 

The MTO demagnetizes the transformer by automatically magnetizing the core 
in the positive and negative direction with multiple cycles of reduced current. 
The demagnetization function is equivalent to generating test currents for 
multiple resistance tests. During the demagnetizations process, the MTO250 will 
display:  

 the number of cycles left in the process in Ω1 display 

 the total demagnetization time on the Ω2 display 

  the demagnetization current applied (-ve and +ve values) 

 'done' is displayed on Ω1 display once demagnetization is complete. 

IMPORTANT POINTS RELATED TO THE DEMAGNETIZATION 
PROCESS: 

1. Demagnetization is only required once after all resistance testing is complete. 

2. Demagnetization time varies with inductance of transformer, and 
demagnetization current chosen. It may be as short as 3 minutes, but as long 
as 30 minutes. 

3. Current and Voltage leads should be attached to one phase/terminal pair on 
high side (Primary) windings for more effective demagnetization.   

4. Ensure voltage leads are attached as discharge energy is absorbed through the 
voltage leads. 

5. For most transformers, it is only required that the middle winding (core) be 
connected for demagnetization. This is a good reason to save the middle 
phase as the last winding resistance test performed (saves connection time – 
more efficient). If demagnetization is not effective with single phase, one can 
perform demagnetization on all 3 windings of the high side of transformer. 
With this process, begin with outer phase and end with middle phase for best 
results. 

6. For best demagnetization results, apply the same current as was used for 
winding resistance test. The MTO250 has an algorithm which calculates 
correct currents for each step in the demagnetization process.   

7. If demagnetization process does not fully demagnetize transformer, operator 
can perform same demagnetization again (at same current) or increase to 
next highest current  

8. If only low winding tested, one can demagnetize either low or high winding. 



M 

AVTMMTO250  Rev 3 June 2015  
32 

9. To validate level of magnetization, use before and after SFRA results or 
perform before and after excitation testing (for each phase). Any significant 
difference denotes residual magnetization. For proper demagnetization, 
difference should to be less than 3mA for excitation current (depending on 
size and construction of transformer) 

Temperature Correction 

It may be necessary to convert the resistance measurements to values 
corresponding to the reference temperature in the transformer test report.  

Conversion of Resistance Measurements 

Winding resistance measurements are normally converted to a standard reference 
temperature. 

The conversions are accomplished by the following formula: 

Rs = Rm ( Ts + Tk )/( Tm + Tk ) 

where 

Rs = resistance at desired temperature Ts 

Rm = measured resistance 

Ts = desired reference temperature 

Tm = temperature at which resistance was measured 

Tk = 234.5 (copper) 

Tk = 225 (aluminum) 
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7  
MTO250 Series PowerDB Lite 

Introduction 

For more information, or updates to the software, visit www.PowerDB.com. 

Minimum Recommended System  

 Operating System: Windows 2000 or later 

 RAM: 64 MB RAM minimum, 512+ MB RAM recommended  

 Processor: 300 MHz Pentium Class processor minimum, 1 GHZ or better 
recommended  

Using PowerDB Lite  

1. Instrument Setup Screen 

1. Select MTO-2XX from the Instrument Setup Screen. 

You can always view the Instrument Setup screen from the Tools menu or 
F3. 
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The MTO 250 uses Ethernet communication. This is the default selection and 
cannot be changed.  

 
a. Click OK on the Instrument Setup Screen to finish.  

2. Fill out the Form 

Manually enter Header and Nameplate Information (for 2XX or 3Ø form) 

3. Download Test Data (2XX form example) 

a. Connect the MTO to your PC via Ethernet cable provided with instrument. 

b. Turn the MTO on. 

c. Wait minimum of 30 seconds, and then click . This 
action will draw the data from the MTO if connections are properly made. 
No action is required from MTO to have data sent to computer. 

 
d. Wait for PowerDB to download all of the data.  The form will be populated 

automatically. 
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4. Manipulate Test Data 

a. Use the Correct to checkbox to change the results from actual readings to 
temperature corrected readings based off of Winding Temp and Correct To 
in the Nameplate data 

 
b. Change the units (Ω, mΩ, uΩ) for each column of resistance data by using 

the dropdown boxes labeled R1 Units & R2 Units. 

 
c. Move test data up/down using the green arrows to the left side of the 

resistance table data. 

 

d. Delete test data by clicking  to the right side of the resistance table data. 

 
e. Fill in Comments/Deficiencies, if applicable. 
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5. Optional: Delete All Test Data On Instrument 

Press  to delete all of the test data on instrument.  

6.  Save The File 

a. Select File -> Save (or CTRL + s) 

b. Manually type in the File name you would like to use. 

7. Open Saved Results 

a. Go to File -> Open (or CTRL + o) 

b. Navigate to your saved file directory and open the file. 

 

 To add results to the file, click . This will create an additional result 
below original result labeled as a date. 

 To view previously saved results, select the test date you want to view and click 

. 

 To delete saved results, select the test date you want to delete and click 

. 
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8. SET LANGUAGE/MEASUREMENT/LOGO OPTIONS 

a. Select Tools -> Options… 

 
b. Select the desired language from the dropdown box. 

c. Select the desired Default Units and Temperature Units. 

d. To change the right/left logo, click the browse button and navigate to the 
logo you wish to use. 

Recommended Procedure for Data Storage & Download 
with Multiple Tap Transformer 

1. Delete all existing test data on instrument (see procedure in Section 5 - General 
Operating Procedures - Stored Data Function - Display/Delete/Download). 

2. Connect leads to measure two windings at the same time. See Table 1-Examples 
on Transformer Connection Schemes for Injecting Test Current and Measuring Two 
Windings Simultaneously as an example of how to connect the leads to take two 
measurements. 

3. Measure the first two windings connected (typically phase A and phase C for 
balance) in the first Data Group. For LTC tap changers, begin at first tap, 
record, change tap without de-energizing test current, and continue recording 
until last tap is measured and recorded.  

4. Connect leads to measure the last winding (phase B in this example), change 
the Data Group to number two, and turn off the R2 measurement. 

5. Take measurements as in Step 3 above for R1. 
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6. Connect the MTO to your PC. 

7. Download the test results to the PowerDB using the 3Ø form. 

 

8. Use the options to configure the data import.  This includes: 

a. Selecting Primary/Secondary/Tertiary Winding 

b. First/Last Tap 

c. R1/R2 Phases for data 

d. Group Number 

 

9. Results can be suppressed row by row by clicking the corresponding checkbox.    
The corresponding Tap# will adjust based on the rows suppressed. 

10. Data can also be suppressed by choosing 'none' from the R1/R2 Phase. 

11. Click Save and Enter More Data if you are entering more than one Phase.  Click 
Save and Close when you are done entering data.  

12. View the results on the graphs provided on the last page(s). 
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8  
Service 

Maintenance 

Maintenance should be performed only by qualified persons familiar with the 
hazards involved with high-voltage test equipment. Read and understand Section 
2, Safety, before performing any service.  

Routine maintenance is required for the MTO test set.  

The appearance of the MTO test set can be maintained by occasionally cleaning 
the case, panel and cable assemblies. 

1. Clean the outside of the carrying case with detergent and water. Dry with a 
clean, dry cloth. 

2. Clean the control panel with a cloth dampened with detergent and water. Do 
NOT allow water to penetrate panel holes, because damage to components on 
the underside may result. An all-purpose, household spray cleaner can be used 
to clean the panel. Polish with a soft, dry cloth, taking care not to scratch the 
display screen cover. 

3. Clean the cables and mating panel receptacles with isopropyl or denatured 
alcohol applied with a clean cloth. 

4. Inspect the cable assemblies occasionally to ensure they are in good condition. 

Calibration 

A complete performance and calibration check should be made at least once 
every year. This will ensure that the MTO test set is functioning and calibrated 
properly over the entire measurement range. The MTO calibration is performed 
on each new or repaired unit before sending it to a customer. There is a special 
MTO final calibration procedure which requires a NIST-traceable test equipment 
to be used. As a result of such calibration procedure, each MTO test set may be 
NIST certified.  

Repairs 

Any service or repair of this equipment should only be performed by qualified 
persons who are aware of electrical hazards and the necessary precautions 
required to prevent injury. 
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Megger offers a complete Repair and Calibration Service and recommends that 
its customers take advantage of this service for routine maintenance or in the 
event of any equipment malfunction. 

In the event that Service is required, contact your Megger representative for a 
product Return Authorization (RA) number and shipping instructions. 

Ship the product prepaid and insured and marked for the attention of the 
Megger Repair Department. Please indicate all pertinent information, including 
catalog number, serial number, and problem symptoms. 

Error Codes 

The MTO comes with a wide range of error codes to assure unit is working 
properly and track down problems in a systematic manner. When an error code 
is observed, the problem may be caused through an internal issue (no possible 
correction by operator) or through an application error (a correctable situation). 
The first step once an error is displayed is to acknowledge the error by pressing 

 and repeating the test or sequence. If the error persists, review the list 
below  or as is noted on the Quick Guide and determine if cause is correctable. If 
the error is not found below, please record error number; contact Megger (or an 
authorized Megger Service Center) for additional assistance. Bold Error codes 
with the possible causes are defined below. 

CODE Error Description Possible Cause 

ESd ESD is in depressed state  Button is pushed down 

IntLoc Interlock is open Interlock Jumper removed 

1XX Ethernet and top panel errors (MTO2XX ONLY)  

102 Ethernet communication failed When connected to PC, check 
connection to computer 

2XX  Initialization errors  

214 EsD – Emergency Off Switch Emergency Switch closed. Lift 
to disengage. 

243 Discharge circuit -temperature too high. Unit 
overheated. 

Fans not operational, long 
continuous use, extreme hot 
test conditions 

244 VICOR circuit -temperature too high. Unit overheated. Fans not operational, long 
continuous use, extremely hot 
test conditions 

3XX ADC_ERROR  

4XX HARDWARE_ERROR  
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CODE Error Description Possible Cause 

411 Current output not insufficient for range selected Resistance of specimen too 
high for current range selected, 
poor current lead connection 

468 Received abort signal Message only with MTO 
software - test was aborted 
within the software by user. 

471 Current not flowing properly while charging Current leads not connected 
properly or problem with 
specimen 

472 Break before make condition Lead removed during testing. 
Test specimen LTC has 
problems. This condition is 
created when >10% current 
change during testing. 

480 Current = 0 Test enabled, with no current 
output, check lead connections. 

494 ESD Abort signal encountered Switch pushed down during test 
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